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1 产品特点 

1.1 产品概述 

XB6 系列插片式 I/O 模组，采用耦合器和 I/O 模块组合

的结构。耦合器将可扩展的 I/O 模块连接到实时工业以

太网系统，I/O 模块通讯背板采用 X-bus 总线，实时性

高、模块种类丰富，为用户高速数据采集、优化系统配

置、简化现场配线、提高系统可靠性等提供保障。 

1.2 产品特点 

占用节点少 

一个节点由一个总线耦合器，1~32 个 X-bus 系列 I/O 模块以及一个末端端盖组成。 

组态灵活 

多种类型插片式 I/O 模块可任意组合。 

功能扩展丰富 

支持灵活扩展，IO 各类齐全，可集成数字量、模拟量、温度、脉冲等模块，种类丰富，可适用不同应用场合

需求。 

兼容性强 

耦合器通信接口符合工业以太网通讯标准，支持主流 EtherCAT 主站。 

支持参数配置 

支持参数配置，自动保存。 

速度快 

背板采用 X-bus 总线：扫描周期最大 1 ms。 

易诊断 

创新的通道指示灯设计，紧贴通道，通道状态直观清晰，检测、维护方便。 
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2 命名规则 

2.1  命名规则 

2.1.1 耦合器命名规则 
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2.1.2  I/O 模块命名规则 

 

 

输入输出特性 

数字量 模拟量 

编码 输入 输出 编码  

A NPN NPN、0.25 A V -10~+10 V、0~+10 V 

B PNP PNP、0.5 A I 4~20 mA、0~20 mA 

BW PNP PNP、0.25 A VW -10~+10 V、0~+10 V 

N NPN/PNP  IW 4~20 mA、0~20 mA 

AN  NPN、0.25A TM 热电阻、热电偶 

BN  PNP、0.5A   
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2.2 常用模块列表 

型号 产品描述 

XB6-EC2002ST EtherCAT 耦合器套件（电源、耦合器） 

XB6-P2000 扩展电源模块 

XB6-3200A/B 32 通道数字量输入模块，NPN/PNP 型 

XB6-0032A/B/BW 32 通道数字量输出模块，NPN/PNP 型 

XB6-1600A/B 16 通道数字量输入模块，NPN/PNP 型 

XB6-0016A/B/BW 16 通道数字量输出模块，NPN/PNP 型 

XB6-0800A/B 8 通道数字量输入模块，NPN/PNP 型 

XB6-0008A/B/BW 8 通道数字量输出模块，NPN/PNP 型 

XB6-1616A/B/BW 16 通道数字量输入输出模块，NPN/PNP 型 

XB6-3200N 32 通道数字量输入，NPN/PNP 兼容 

XB6-0032AN 32 通道数字量输出，NPN 型 

XB6-0032BN 32 通道数字量输出，PNP 型 

XB6-0012J 12 通道继电器输出模块 

XB6-A80V 8 通道模拟量输入模块 

量程可选：0~+10 V 、-10~+10 V 
XB6-A40V 4 通道模拟量输入模块 

XB6-A08V 8 通道模拟量输出模块 

XB6-A04V 4 通道模拟量输出模块 

XB6-A80I 8 通道模拟量输入模块 

量程可选：0~20 mA 、4~20 mA 
XB6-A40I 4 通道模拟量输入模块 

XB6-A08I 8 通道模拟量输出模块 

XB6-A04I 4 通道模拟量输出模块 

XB6-A80VW 8 通道模拟量输入模块 

量程可选：0~+10 V 、-10~+10 V 
XB6-A40VW 4 通道模拟量输入模块 

XB6-A08VW 8 通道模拟量输出模块 

XB6-A04VW 4 通道模拟量输出模块 

XB6-A80IW 8 通道模拟量输入模块 

量程可选：0~20 mA 、4~20 mA 
XB6-A40IW 4 通道模拟量输入模块 

XB6-A08IW 8 通道模拟量输出模块 

XB6-A04IW 4 通道模拟量输出模块 

XB6-A40TM 4 通道热电阻、热电偶温度采集模块 

XB6-A80TM 8 通道热电阻、热电偶温度采集模块 

XX6-C18_2 公共端扩展模块 
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3 产品参数 

3.1 通用参数  

通用技术参数 

规格尺寸 电源模块 106◊61◊22.5 mm 

耦合器模块 106◊61◊22.5 mm 

I/O 模块 106◊73◊25.7 mm 

重量 电源模块 110 g 

耦合器模块 80 g 

I/O 模块 90 g 

工作温度 -10~+60℃  

存储温度 -20℃~+75℃  

相对湿度 95%，无冷凝  

防护等级 IP20  

3.2 电源参数 

电源参数 

电源模块 工作电源 18~36 VDC 

输出电压 5 VDC 

输出电流 2 A、4 A 

耦合器模块 工作电源 5 VDC 

工作电流 400 mA 

I/O 模块 工作电源 5 VDC 
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3.3 接口参数 

EtherCAT 接口参数 

总线协议 EtherCAT（MDP）  

I/O 站数量 根据主站设置 

数据传输介质 Ethernet/EtherCAT CAT5 电缆 

传输距离 ≤100 m（站与站距离） 

传输速率 100 Mbps 

总线接口 2◊RJ45 

3.4 数字量参数 

信号类型 

数字量输入   

额定电压 24 VDC(±25%) 

信号点数 8、16、32 

信号类型  NPN/ PNP 

“0”信号电压（PNP） -3~+3 V 

“1”信号电压（PNP） 15~30 V 

“0”信号电压（NPN） 15~30 V 

“1”信号电压（NPN） -3~+3 V 

输入滤波 3 ms（默认） 

输入电流 4 mA 

隔离方式 光耦隔离 

隔离耐压 500 V 

通道指示灯 绿色 LED 灯 

晶体管输出   

额定电压 24 VDC(±25%) 

信号点数 8、16、32 

信号类型 NPN/ PNP 

负载类型 阻性负载、感性负载 

单通道额定电流(A/B) Max：500 mA 

单通道额定电流(BW) Max：250 mA 

端口防护 过压、过流保护 

隔离方式 光耦隔离 

隔离耐压 500 V 

通道指示灯 绿色 LED 灯 

继电器输出   

额定电压 24 VDC(±25%) 

信号点数 12 

隔离方式 光耦、继电器 

额定负载 5 A 

通道指示灯 绿色 LED 灯 
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3.5 模拟量参数 

3.5.1 技术参数 

型号类型 

模拟量输入 输入点数 4、8  

输入信号（电压型） 0~+10 V、-10 V~+10 V

（量程可调）  

 

输入信号（电流型） 0~20 mA、4~20 mA（量

程可调） 

 

分辨率 16 bit  

采样速率 

Ax0V ≤1 ksps 

Ax0VW ≤62.5 sps 

Ax0I ≤1 ksps 

A40IW ≤100 sps 

A80IW ≤62.5 sps 

精度 

Ax0V ±0.1% 

Ax0VW ±0.3% 

Ax0I ±0.1% 

Ax0IW ±0.3% 

输入阻抗（电压型） ≥2 kΩ  

输入阻抗（电流型） 100 Ω  

隔离耐压 500 V  

通道指示灯 绿色 LED 灯  

温度输入 通道数 4、8  

传感器类型 热电偶 热电阻 

 K：-200~1370℃ 

J： -200~1200℃ 

E:  -200~1000℃ 

S:  -50~1690℃ 

B:   50~1800℃ 

Pt100：−200~850℃ 

Pt200：−200~600℃ 

Pt500：−200~600℃ 

Pt1000：−200~600℃ 

分辨率 16 bit  

灵敏度 0.1℃  

通道指示灯 绿色 LED 灯  

模拟量输出 输出点数 4、8  

输出信号（电压型） 0~+10 V、-10~+10 V

（量程可调） 

 

输出信号（电流型） 0~20 mA、4~20 mA（量

程可调） 

 

分辨率 16 bit  

负载阻抗（电压型） ≥2 kΩ  
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负载阻抗（电流型） ≤200 Ω  

精度 

A0xV ±0.1% 

A0xVW 未发布 

A0xI ±0.1% 

A0xIW ±0.3% 

隔离耐压 500 V  

通道指示灯 绿色 LED 灯  

3.5.2 电压输入/输出量程选择及码值表 

电压输入/输出量程选择及码值范围 

量程选择 0 1 2 3 

量程范围 -10 V~+10 V 0~+10 V -10 V~+10 V 0~+10 V 

码值范围 -32768~32767 0~32767 -27648~27648 0~27648 

电压输入 

计算公式 
D=(65535/20)*U D=(32767/10)*U D=(55296/20)*U D=(27648/10)*U 

电压输出 

计算公式 
U=(D*20)/65535 U=(D*10)/32767 U=(D*20)/55296 U=(D*10)/27648 

码值 

对应表 
参见表 1 电压码值表。 

注：D 码值  U 电压 

表 1 电压码值表 

量程 

电压 

0（默认） 1 2 3 

码值 码值 码值 码值 

-10 -32768    -27648    

-9 -29491    -24883    

-8 -26214    -22118    

-7 -22937    -19354    

-6 -19661    -16589    

-5 -16384    -13824    

-4 -13107    -11059    

-3 -9830    -8294    

-2 -6554    -5530    

-1 -3277    -2765    

0 0  0  0  0  

1 3277  3277  2765  2765  

2 6554  6553  5530  5530  

3 9830  9830  8294  8294  

4 13107  13107  11059  11059  

5 16384  16384  13824  13824  

6 19661  19660  16589  16589  
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7 22937  22937  19354  19354  

8 26214  26214  22118  22118  

9 29491  29490  24883  24883  

10 32767  32767  27648  27648  

  

码值=（65535/20）

*电压 

码值=（32767/10）

*电压 

码值=（55296/20）

*电压 

码值=（27648/10）

*电压 

  

电压=（码值*20）

/65535 

电压=（码值*10）

/32767 

电压=（码值*20）

/55296 

电压=（码值*10）

/27648 

 

3.5.3 电流输入/输出量程选择及码值表 

 

模拟电流输入输出量程选择及码值范围 

量程选择 0 1 2 3 

量程范围 4~20 mA 0~20 mA 4~20 mA 0~20 mA 

码值范围 0~65535 0~27648 

电流输入

计算公式 
D=65535/16*I-16384 D=(65535/20)*I D=(27648/16)*I-6192 D=(27648/20)*I 

电流输出

计算公式 
I=(D+16384)*16/65535 I=(D*20)/65535 I=((D+6192)*16)/27648 I=(D*20)/27648 

码值 

对应表 
参见表 2 电流码值表。 

注：D 码值   I 电流 
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表 2 电流码值表 

量程选择 

量程范围 

 

电流 

0（默认） 1 2 3 

4-20mA 0-20mA 4-20mA 0-20mA 

码值 

 

码值 码值 

 

码值 

0   0    0  

1   3277    1382  

2   6554    2765  

3   9830    4147  

4 0  13107  0  5530  

5 4096  16384  1728  6912  

6 8192  19661  3456  8294  

7 12288  22937  5184  9677  

8 16384  26214  6912  11059  

9 20479  29491  8640  12442  

10 24575  32768  10368  13824  

11 28671  36044  12096  15206  

12 32767  39321  13824  16589  

13 36863  42598  15552  17971  

14 40959  45875  17280  19354  

15 45055  49151  19008  20736  

16 49151  52428  20736  22118  

17 53247  55705  22464  23501  

18 57343  58982  24192  24883  

19 61439  62258  25920  26266  

20 65535  65535  27648  27648  

21 65535  65535  29376  29030  

22   31104  30413  

22.81423611   32511  31538  

22.96238426   32767  31743  

23   32767  31795  

23.51779514    32511  

23.70298032    32767  

24    32767  

25     

 

码 值 =65535/16*

电流-16384 

码值=（65535/20）

*电流 

码值=（27648/16）

*电流-6912 

码值=（27648/20）

*电流 

注：量程 2 输入电流＞22.81 mA 时，码值均显示 32767；指定码值＞32511 时，输出电流均为 22.81 mA。 

量程 3 输入电流＞23.52 mA 时，码值均显示 32767；指定码值＞32511 时，输出电流均为 23.52 mA。 
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3.6 公共端扩展模块参数 

公共端子 

额定电压 125 VDC/AC 250V 

额定电流 8 A 

公共端数量 2 组 
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4 面板 

4.1 耦合器面板 

本节介绍耦合器各部位名称和功能。 

 

电源部分标识及指示灯说明 

标识 名称 颜色 指示灯状态 解释 

P 5V 指示灯 绿色 常亮 工作电源正常 

闪烁 超载 80%，切断对后级负载供电 

熄灭 产品未供电或电源异常 

O 过载指示灯 红色 熄灭 未超载 

常亮 负载达到 90% 

闪烁 超载 80%，切断对后级负载供电 
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系统部分标识及指示灯说明 

标识 名称 颜色 含义 解释 

P 电源指示灯 绿色 常亮 工作电源正常 

   熄灭 产品未供电或电源供电异常 

L  绿色 熄灭 初始化状态或未上电 

   常亮 X-bus 总线正在交互 

   闪烁：1 Hz 底部总线初始化正常 

   闪烁：5 Hz 底部总线初始化异常 

   闪烁：10 Hz 运行中出现 I/O 模块丢失响应 

E 错误指示灯 红色 常亮 耦合器出现异常状态 

   熄灭 初始化状态、未上电或无错误 

R  绿色 熄灭 初始化状态或未上电 

EtherCAT Init 状态 

   常亮 EtherCAT OP 状态 

   闪烁：5 Hz EtherCAT PreOP 状态 

   闪烁：熄灭 1 s 

     常亮 200 ms 

EtherCAT SafeOP 状态 

IN  黄色 闪烁 连接建立并有数据交互 

   熄灭 无数据交互或异常 

OUT  黄色 闪烁 连接建立并有数据交互 

   熄灭 无数据交互或异常 

4.2 I/O模块面板 

介绍模块各部位名称和功能。 
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指示灯说明 

P 绿色 常亮 电源供电正常 

 熄灭 产品未上电或电源供电异常 

R 绿色 常亮 系统运行正常 

 闪烁 1 Hz I/O 模块已连接，X-bus 系统准备交互 

 熄灭 设备未上电、X-bus 未交互数据或异常 

输入通道指示 绿色 常亮  模块检测通道有信号输入 

 熄灭 模块通道无信号输入或信号输入异常 

输出通道指示 绿色 常亮 模块通道有信号输出 

  常亮/熄灭 模块通道无信号输出或信号输出异常 

 



XB6 系列_EtherCAT_插片式 I/O 用户手册  5 安装和拆卸 

 

版权所有 © 南京实点电子科技有限公司 2018                               

17 

5 安装和拆卸 

5.1 安装指南 

模块安装注意事项 

● 确保柜内有良好的通风措施。 

● 请勿将本设备安装在可能产生过热的设备旁边或者上方。 

● 务必将模块竖直安装、并保持周围空气流通（模块上下至少有 50mm 的空气流通空间）。 

● 模块安装后，务必在模块两端安装导轨固定件将模块固定。 

● 安装\拆卸务必在切断电源的状态下进行。 

模块安装最小间隙（≥50 mm） 

 

确保模块竖直安装 
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务必安装导轨固定件 

 

 

 

 

 

 

 

5.2 应用配置 

 

 

应用方式： 

采用电源模块、耦合器、数字量、模拟量、继电器、温度、脉冲、编码器接口、步进驱动等模块组合的应用方

式。 

应用配置： 

根据主站接入能力、站点数量、I/O 点数、功能类型等要求，可适应不同型号 I/O 模块组合配置。 

配置规则： 

模组自左至右依次为电源模块、耦合器模块、I/O 模块、端盖（必须配置）等。 

 

I/O 模块 

功能模块 

 

 

耦合器模块 

 

 

I/O 模块 

功能模块 

 

 

端盖 

 

 

扩展 

电源模块 
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5.3 安装拆卸步骤 

模块安装及拆卸 

模块安装步骤 1. 在已固定的导轨上先安装电源模块。 

2. 在电源模块的右边依次安装耦合器及所需要的 I/O 模块。 

3. 安装所有需要的 I/O 模块后，安装端盖，完成模块的组装。 

4. 在电源模块、端盖的两端安装导轨固定件，将模块固定。 

模块拆卸步骤 1. 松开模块两端的导轨固定件。 

2. 用一字螺丝刀撬开模块卡扣。 

3. 拔出拆卸的模块。 

5.4 安装示意图 

一、 电源模块安装 

1. 将电源模块导轨卡槽，垂直对准导轨，如图所示。 
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2. 用力压电源模块，听到“咔哒”响声，模块即安装到位，如图所示。 

 
二、 耦合器模块安装 

1. 将耦合器模块左侧卡槽对准电源模块右侧，如图所示推入。 

 

2. 用力将模块压入导轨，听到“咔哒”响声，模块即安装到位。 

三、 I/O 模块安装 

按照上一步安装耦合器模块的步骤，逐个安装所需要的 IO 模块。 
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四、 端盖加装 

在最后一个模块的右侧安装端盖，安装方式请参照耦合器模块安装方法。 

 

五、 导轨固定件加装 

1. 紧贴耦合器左侧面安装并锁紧导轨固定件。 

 
2. 在端盖右侧安装导轨固定件，先将导轨固定件向耦合器的方向用力推，确保模块安装紧固，并用螺

丝刀锁紧导轨固定件。 
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六、 拆卸（用一字平头起） 

1. 用螺丝刀松开模块一端导轨固定件，并向一侧移开，确保模块和导轨固定件之间有间隙。 

 

2. 将一字平头起插入待拆卸模块的卡扣，侧向模块的方向用力（听到响声）。 

注：每个模块上下各有一个卡扣，均按此方法操作。 
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3. 按安装模块相反的操作，拆卸模块。 

 

5.4 外形尺寸 

电源模块外形规格  安装方式 

 

 

 

 

 

DIN 35 mm 导轨安装 
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耦合器外形规格  安装方式 

 

中间电源模块外形规格  安装方式 

 

I/O 模块外形规格  安装方式 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

DIN 35 mm 导轨安装 

 

 

DIN 35 mm 导轨安装 

 

DIN 35 mm 导轨安装 
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端盖外形规格  安装方式 

 
 

*DIN 导轨规格 35*7.5*1.0， 35*15*1.0 
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6 接线  

6.1 接线端子 

接线端子 

信号线端子 极数 16 P 

极数 20 P 

线径 28 -16 AWG  0.2-1.5 mm² 

电源端子 极数 3P 

线径 26 -12 AWG  0.5-2.5mm² 

总线接口 2*RJ45 5 类以上的 UTP 或 STP（推荐 STP） 

6.2 接线说明及要求 

电源接线注意事项 

 

 

⚫ 模块系统侧电源及现场侧电源需分开配置，请勿混合使用。 

⚫ PE 需可靠接地。 
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工具及接线要求 

接线工具要求 

端子采用免螺丝设计，线缆的安装及拆卸均可使

用一字型螺丝刀操作（规格：≤3 mm）操作。 

 

剥线长度要求 

推荐剥线长度 10 mm 

 

接线方法 

单股硬导线，剥好对应长度的导线后，下压按钮

同时将单股导线插入。 

 

多股柔性导线，剥好对应长度的导线后，可以直

接连接或者配套使用对应标准规格的冷压端头

（管型绝缘端子，如下表），下压按钮同时将线

插入。  

 

管型绝缘端头规格表 

规格要求 型号 导线截面积 mm² 

 

管型绝缘端子 L 的长度为≥10 mm 

E0510 0.5 

E7510 
0.75 

E7512 

E1010 
1.0 

E1012 

E1510 
1.5 

管型绝缘端子 L 的长度为≥10 mm E1518 

                                                                  

电源接线 

电源模块 3P 端子 

使用 DC24V 电源模块，参照接线方法，根据下图所示电路，将电源接好，同时将 PE 

可靠接地。(电源线推荐选用双绞线) 

⚫ 耦合器、IO 模块 、电源接线图，如下所示。 



XB6 系列_EtherCAT_插片式 I/O 用户手册  6 接线 

 

版权所有 © 南京实点电子科技有限公司 2018                               

28 

 

⚫ 耦合器、IO 模块、电源模块、IO 模块、 电源接线图，如下所示。 
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负载电源接线   

现场侧 20P 端子 

参照相应 I/O 模块接线图及接线方法将信号线线缆压入接线端子。 

负载电源使用 24 VDC 电源供电，参照接线方法，根据左图所示电路，将电源接好， 

具体参考 6.3  I/O 模块接线图。 

 

信号端子接线 

16P\20P 端子 

参照相应 I/O 模块接线图及接线方法将信号线线缆压入接线端子 

总线接线 

工业以太网总线通讯接口 

采用标准 RJ45 网络接口与标准水晶接头，引脚分配如下图所示。 

 

 

 

⚫ 推荐使用类别 5 或更高等级的双屏蔽（编织网+铝箔）STP 电缆作为通讯电缆。 

⚫ 设备之间线缆的长度不能超过 100 m。 

 

 

  

引脚号 信号 

1 TD+ 

2 TD- 

3 RD+ 

4 - 

5 - 

6 RD- 

7 - 

8 - 
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6.3  I/O模块接线图 

接线时，正负极只需要接一组，内部正与正导通，负与负极导通。 

XB6-3200A  模块面板 

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

DIa

DIb

Power +24 V

Power 0 V

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Power +24 V

Power 0 V

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

  

 

XB6-3200B  模块面板 

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

DIa

DIb

Power +24 V

Power 0 V

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Power +24 V

Power 0 V

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F
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XB6-1616A  模块面板 

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

DI

DO

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

  

 

 

XB6-1616B  模块面板 

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

DI

DO

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F
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XB6-1600A  模块面板 

Power +24 V

Power 0 V

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Power +24 V

Power 0 V

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

DI

  

 

XB6-1600B  模块面板 

Power +24 V

Power 0 V

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Power +24 V

Power 0 V

Input 8

Input 9

Input A

Input B

Input C

Input D

Input E

Input F

DI
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XB6-0800A  模块面板 

DI

Power +24 V

Power 0 V

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Power +24 V

Power 0 V

  

 

XB6-0800B  模块面板 

DI

Power +24 V

Power 0 V

Input 0

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

Power +24 V

Power 0 V

  

XB6-0032A  模块面板 
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DOa

DOb

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

  
 

 

XB6-0032B  模块面板 

 

DOa

DOb

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F
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XB6-0016A  模块面板 

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

DO

  

 

XB6-0016B  模块面板 

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

Output 8

Output 9

Output A

Output B

Output C

Output D

Output E

Output F

DO
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XB6-0008A  模块面板 

DO

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V

  

 

XB6-0008B  模块面板 

DO

Power +24 V

Power 0 V

Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

Power +24 V

Power 0 V
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XB6-0012J  模块面板 

Power +24V

Power 0 V

Output 0

DOa

Output 1

Output 2

Output 3

Output 4

Output 5 COM

COM

COM

COM

COM

COM

Output 6

Output 7

Output 8

Output 9

Output A

Output B COM

COM

COM

COM

COM

COM

Power +24V

Power 0 V

DOb

  

XB6-A80V/XB6-A80I  模块面板 

COMInput 

Input 1

Input 2

Input 3

Input 4

Input 5

Input 6

Input 7

COM

COM

COM

COM

COM

COM

COM

两线制传感器
+24V

0V
三线制传感器

四线制传感器

+24V
0V

+24V
0V

信号线缆：建议采用屏蔽双绞线*
  

 

 

 

说明： 

XB6-A80I 模块丝印为 XB6-A80I 
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XB6-A40V/XB6-A40I  模块面板 

 

COM

AI
Input 

Input 1

Input 2

Input 3

COM

COM

COM

COM

COM

COM

COM

两线制传感器
+24V

0V
三线制传感器

四线制传感器

+24V
0V

+24V
0V

信号线缆：建议采用屏蔽双绞线*
 

 

 

 

XB6-A08V\XB6-A08I  模块面板 

Power +24 V

Power 0 V

Power +24 V

Power 0 V

COMOutput 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

COM

COM

COM

COM

COM

COM

COM

信号线缆：建议采用屏蔽双绞线*
  

说明： 

XB6-A40I 模块丝印

为 XB6-A40I 

 

说明： 

XB6-A08I 模块丝印为 

XB6-A08I 
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XB6-A04V\XB6-A04I  模块面板 

Power +24 V

Power 0 V

Power +24 V

Power 0 V

COM

AO
Output 0

Output 1

Output 2

Output 3

Output 4

Output 5

Output 6

Output 7

COM

COM

COM

COM

COM

COM

COM

信号线缆：建议采用屏蔽双绞线*
 

6.4  公共端扩展模块接线图 

本节说明以 XX6-1616A/B 两种模块为例，介绍两线制、三线制传感器的接线方式。 

两线制传感器（NPN 型）接线方式 

 

说明： 

XB6-A04I 模块丝印为 

XB6-A04I 

 



XB6 系列_EtherCAT_插片式 I/O 用户手册  6 接线 

 

版权所有 © 南京实点电子科技有限公司 2018                               

40 

两线制传感器（PNP 型）接线方式 

 

三线制传感器（NPN 型）接线方式 

 

三线制传感器（PNP 型）接线方式 
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7 使用 

7.1 模块应用 

7.1.1 应用方式 

产品采用耦合器、I/O 模块、端盖的应用方式，有以下两种组合应用。 

产品组合方式一（耦合器、I/O 模块、端盖） 

耦合器 I/O 模块 端盖 

 

 

产品组合方式二（耦合器、I/O 模块、电源模块、I/O 模块、端盖） 

耦合器 I/O 模块 电源模块 I/O 模块 端盖 

 

I/O 模块配置数量请参照以下原则： 
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● 系统配置的 I/O 模块型号及数量，所消耗的功耗最大数值务必要小于电源模块所提供的负载电流。 

● 耦合器所能配置 IO 模块数量≤32 个。 

● 模拟量模块数量不能超过 12 个，且 8 通道模拟量输入不允许超过 8 个。 

● 一个电源支持 10 个 I/O 设备，若超过 10 个设备，需要增加电源。 

7.1.2 电源模块配置数量及功耗计算 

电源模块配置原则 

系统配置的 I/O 模块型号及数量，所消耗的功耗最大数值务必要小于电源模块所提供的负载电流。 

I/O 模块型号及数量确定后，可通过我司“实点 XB6 系列 I/O 功耗计算表”进行计算，从而合理配置耦合

器及电源模块数量。 

“实点 XB6 系列 I/O 功耗计算表”网址：https://www.solidotech.com/documents/tools 

耦合器及电源模块配置数量示例： 

系统所需 I/O 模块、数量及功耗如下： 

 

类型 型号· 数量 功耗 

IO 模块 

XB6-3200A 1 55 mA 

XB6-1600A 1 50 mA 

XB6-0032A 4 180 mA 

XB6-0016A 1 110 mA 

XB6-1616A 5 120 mA 

XB6-A80V 1 230 mA 

总功耗  1685 mA 

结论： 

所有模块的功耗和 1685 mA 大于耦合器所提供 I/O 模块电源电流 1600 mA，因此需要增加一个电源模

块。 

7.2 耦合器功能说明 

本章节以 TwinCAT3 软件平台为例，介绍耦合器功能。 

拓扑配置 

系统支持自动扫描配置及手动配置。 

⚫ 手动配置： 

在 SLOT 中选择目标模块，不同主站显示位置不同。 

添加耦合器后，在 Slots 页面单击 和 进行拓扑配置，例如下图所示，详情请参考 

7.4.1 在 TwinCAT3 软件环境下的应用。 

https://www.solidotech.com/documents/tools
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⚫ 自动扫描配置： 

详情请参考 7.4.1 在 TwinCAT3 软件环境下的应用。 

参数设置 

支持 P > S 设置，启动参数。 

添加耦合器后，在“Startup”页面，右键选择“Insert”，进行参数设置，例如下图所示。 

 

⚫ 主站使用启动参数配置功能，在创建工程时配置 IO 模块参数。 

⚫ 主站使用 SDO 方式修改参数，完成操作后，模块自动保存并立即生效，在不改变拓扑情况下，参

数始终保存。 

说明：如果设备处于 OP 状态下，修改输出性质的模块时，此时的输出信号会被清空并立即以新参

数运行。 

建议使用启动参数方式配置 IO 模块，同时完成配置后对系统断电再上电以确认参数是否准确下

发。 
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耦合器控制字/状态字 

 XB6-EC0002 支持 2 字节的控制字（“CouplerState”）和 2 字节的状态字（“CouplerState”），如

下表所示： 

  

CouplerState 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 

 
预留 X-bus 错误码显示区 

[15-4] 预留 

[3-0] X-bus 运行状态，正常为“0”。 

CouplerCtrl 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0 

CouplerCtrl 通过设置控制字写 bit0 位，可实现在异

常状态下，输出类型的模块保持通道持续输出。 
预留 

清空/保持 

[15-1] 预留 

[0] 

0：默认，清空控制。 

1：保持控制， 默认“0”。 

更正后立即生效。 
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7.3 模块参数设置功能 

本章节以 TwinCAT3 软件平台为例，介绍模块参数、功能以及配置方法。 

7.3.1 数字量输入滤波时间 

数字量输入滤波可防止程序响应输入信号中的意外快速变化，这些变化可能因开关触点跳跃或电气噪声产

生。数字量输入滤波目前固定配置为 3ms，可以滤除 3ms 之内的杂波，通道不可单独配置。 

3 ms 的输入滤波时间表示单个信号从 0 变为 1，或从 1 变为 0 持续 3 ms 才能够被检测到，而短于 3 ms

的单个高脉冲或低脉冲不会被检测到。 

7.3.2 模拟量滤波设置功能 

模拟量输入滤波功能 

模拟量输入滤波功能，可以将 A/D 转换后的数据，在内部进行平均，用于降低由于输入信号因噪声等受到

的波动影响。 

模拟量输入以指定的 A/D 转换次数进行移动平均处理。 

滤波功能配置 

每个通道可单独配置，配置范围：1~200，默认 10。 

8 通道模块采样速率为: 1.25KHZ/8 通道(800us/8 通道)。 

4 通道模块采样速率为：2.5KHZ/4 通道(400us/4 通道)。 

配置完成后，建议重新上电。 

1. 单击“TwinCAT Project > I/O > Devices > Device (EtherCAT) > Box 1(XB6-EC002)”进入配置界

面，切换到“Startup”页面。 

2. 右键单击“Insert”，如下图所示。 

 

3. 双击选中已有型号的模块，本例 XB6-A80V，选中对应的通道，进行滤波参数设置，如下图。 
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7.3.2 输出清空保持功能 

保持输出：通讯断开时，模块输出通道一直保持输出。 

清空输出：通讯断开时，模块输出通道清空输出。 

输出清空保持功能配置 

以 TwinCAT3 软件平台为例介绍输出清空保持功能的配置方法。 

1. 在树状目录下，双击“CouplerCtrl”。 

2. 切换到“Online”页面，如下图所示。 
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3. 单击“Write”，修改“CouplerCtrl”值。 

 

Dec 配置为“0”，表示清空输出。 

Dec 配置为“1”，表示保持输出。 
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7.3.4 模拟量量程选择 

模拟量支持量程选择功能，具体详见 3.5 模拟量参数。 

本手册以 TwinCAT3 软件为例介绍模拟量模块的量程配置方法。 

1. 在配置界面左侧导航树中，选中“Box 1(XB6-EC0002)”。 

2. 选中模拟量，右键单击“Insert”，进入“Edit CANopen Startup Entry”界面。 

2. 双击修改模块的通道，出现“Set Value Dialog”对话框，如下图所示，根据量程范围进行修改，修

改完成后，模块需重新上电。 
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7.4 总线模块组态说明 

7.4.1 在 TwinCAT3 软件环境下的应用 

1. 准备工作 

硬件环境 

计算机一台，预装 TwinCAT3 软件。 

EtherCAT 专用屏蔽电缆。 

开关电源一台。 

模块安装导轨及导轨固定件。 

模块型号及类型，如下表： 

类型 型号 数量 

耦合器 XB6-EC2002ST 1 

IO 

模块 

XB6-3200A 1 

 XB6-0032A 4 

 XB60032B 1 

 XB6-A40V 1 

端盖 XB6-CVR00 1 

设备配置文件   

配置文件获取地址：https://www.solidotech.com/documents/configfile 

硬件组态及接线 

请按照“5 安装和拆卸和 6 接线要求操作。 

2. 添加设备配置文件 

将 ESI 配置文件（例如：“EcatTerminal-XB6_VX.XX_ENUM.xml”）放入 TwinCAT 的安装目录： 

“C:\TwinCAT\3.1\Config\Io\EtherCAT”，如下图。 

 

3. 添加设备 

1. 打开 TwinCAT 软件。 

2. 单击“New TwinCAT Project”新建项目，如下图所示。 

https://www.solidotech.com/documents/configfile
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3. 单击“OK”。 

4. 添加设备。 

模块支持“自动扫描”和“手动添加”两种模式进行设备配置。 

⚫ 自动扫描配置 

1. 单击“I/O > Devices”，右键单击“Scan”，进行从站设备扫描。 

 

2. 勾选“本地连接”网卡。 
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3. 单击“OK”。 

4. 在弹出的“Scan for boxes”对话框中选择“是”，如下图所示。 

 
5. 在弹出的“Activate for Run”选择“是”，如下图所示。 

 

例如：扫描到的“Box 1(XB6-EC0002)”为耦合器。 

查看连接在 Box1 下的子模块，此模块下连接 4 个模块，如下图所示。 
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⚫ 手动添加设备 

1. 单击“I/O > Devices”，右键单击“Add New Item”，弹出如下窗口。 

 

2. 选择“EtherCAT > EtherCAT Master”，单击“OK”。 

3. 在弹出的窗口中选择以太网。 

4. 单击“I/O > Devices”，右键单击“Add New Item”，弹出如下窗口， 

选择耦合器。 

    

5. 添加设备。 
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在“Slots”页签，添加设备。 

4. 数据交互 

数字量输入： 

以XB6-3200B模块为例：在该模块的“Inputs”中监测输入信号，如下图： 

 

数字量输出： 

以XB6-0032B为例：若要让该模块通道17输出，操作步骤如下： 

1. 选择“TwinCAT Project > I/O > Box 1(XB6-EC002) > Module 2(XB6-3200B) > Outputs > 

Channel 17”。 

2. 切换到“Online”。 

3. 单击“Write”，将“Dec”配置为“1”。 
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4. 单击“OK”，可以看到该模块对应的通道指示灯亮起。 

7.4.2 在 Sysmac Studio 软件环境下的应用 

1. 准备工作 

硬件环境 

计算机一台，预装 Sysmac Studio 软件 

欧姆龙 PLC 型号：NX1P2 9024DT 

EtherCAT 专用屏蔽电缆 

开关电源一台 

模块安装导轨及导轨固定件 

模块型号及类型，如下表： 

类型 型号· 数量 

耦合器 XB6-EC2002ST 1 

IO 模块 XB6-3200A 1 

 XB6-0032A 4 

 XB60032B 1 

 XB6-A40V 1 

端盖 XB6-CVR00 1 

设备配置文件   

配置文件获取地址：https://www.solidotech.com/documents/configfile 

硬件组态及接线 

请按照 5 安装和拆卸和 6 接线要求操作。 

计算机 IP 要求 

设置电脑的 IP 地址和 PLC 的 IP 地址，确保其在同一网段。 

2. 添加设备描述文件。 

1. 登录 Sysmac Studio。 

2. 单击“新建工程”按钮。 

https://www.solidotech.com/documents/configfile
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在“设备”和“版本”下拉列表中选择“设备”，“型号”和“版本”。 

3. 选择“控制器 > 通信设置”。 

1. 选择在线时每次与控制器连接时使用的方法，输入“远程 IP 地址”，例如下图所示。 

 

2. 单击“Ethernet 通信测试”，系统显示测试成功。 

3. 添加 XML 文件。 

1. 在左侧导航树展开“配置和设置”，双击“EtherCAT”。 

2. 右击“主设备”，选择“显示 ESI 库”，如下图所示。  
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3. 在弹出的“ESI 库”窗口中单击“安装(文件)”按钮，选择 XML 文件路径。 

4. 添加设备 

添加耦合器 

1. 在左侧导航树展开“配置和设置”，双击“EtherCAT”，显示“节点设置|网络设置”页面。 

2. 在右侧导航栏“全部供应商”下拉列表选择“Nanjing Solidot Electronic Technology Co., Ltd”，

如下图所示。  

 

3. 双击 XB6-EC0002 添加耦合器模块，如下图所示。 
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⚫ 添加 I/O 模块 

单设备连接： 

1. 选中刚添加的耦合器模块，右键从菜单选项中选择“编辑模块配置”，如下图所示。 

 

2. 光标定位到“模块”中，在右侧列表中单击模块，按 I/O 模块组态的顺序，逐个添加 I/O 模块。 

 

多设备级联： 

1. 选中添加的耦合器模块，右键从菜单选项中选择“编辑模块配置”。 

2. 单击上方菜单栏“控制器 > 在线”。 

3. 右键主设备图标，选择“写入从设备节点地址”，如下所示，写入与“当前值”不一样的“设置值”。 
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4. PLC 和设备同时重新上电。 

5. 右键主设备图标，选择“与物理网络配置比较合并”。 

5. 配置下载 

单击“控制器 > 传送中 > 传送到控制器”将在线数据传送到控制器中。 

6. 通道测试 

在左侧导航树中双击“I/O映射”，选择对应的I/O模块，可对通道数据进行查看及操作。 

 
7. 模块参数设置 

输出清空保持功能 

1. 双击左侧导航树“I/O 映射”，显示“I/O 映射”窗口。 

2. 展开节点，在系统运行状态下，对应“Outputs_CouplerCtrl_F200_01”写入“01”完成清空/保

持功能设置。 
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0：输出清空 

1：输出保持 

模拟量量程选择及滤波设置 

1. 在左侧导航树中双击节点，选择对应的输入模块。 

2. 系统离线后，单击“编辑初始化参数设置”按钮。 

  

3. 量程选择及滤波设置 

在“编辑初始化参数设置”页面，可进行量程选择和滤波设置。具体参数详见 7.3 模块参数设

置功能。 
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7.4.3 在 CODESYS V3.5 软件环境下的应用 

1. 准备工作 

硬件环境 

计算机一台，预装 CODESYS V3.5 软件 

EtherCAT 专用屏蔽电缆 

开关电源一台 

模块安装导轨及导轨固定件 

模块型号及类型，如下表： 

类型 型号 数量 

耦合器 XB6-EC0002 1 

IO 

模块 

XB6-3200A 1 

 XB6-0032A 4 

 XB60032B 1 

 XB6-A40V 1 

端盖 XB6-CVR00 1 

设备配置文件   

配置文件获取地址：https://www.solidotech.com/documents/configfile 

硬件组态及接线 

请按照 5 安装和拆卸和 6 接线要求操作。 

2. 安装设备配置文件 

1. 安装 EhterCAT XML 设备描述文件(“EcatTerminal-XB6_VX.XX_ENUM.xml”) 

1. 登录 CODESYS。 

2. 选择“Tools > Device Repository”。 

3. 单击“Install”，选择相关 XML 文件进行安装。 

成功安装，显示“Device xxxx installed to device repository”。 

 

https://www.solidotech.com/documents/configfile
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2. 添加 EtherCAT Master。 

1. 双击左侧导航树中“Device(CODESYS Control Win V3 X84)”，单击“扫描网络”。 

2. 选择设备，扫描网络，例如： 

 

3. 选中左侧导航树中“Device(CODESYS Control Win V3 X84)”，右键选择“Add Device”，

如下图所示。 

 

4. 选择“EtherCAT Master”，如下图所示。 
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5. 单击“Add Device”，在设备列表框中按回车键，激活设备。 

3. 配置“EtherCAT Master”。 

1. 双击“EtherCAT Master(EtherCAT_Master)”。 

2. 单击“Browse”，在弹出的对话框中选择“以太网”，例如： 

 

4. 配置设备。 

模块支持自动扫描和手动添加两种模式进行设备配置。 
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● 自动扫描设备 

1. 选中“EtherCAT_Master (EtherCAT Master)”，单击“Scan For Devices”，如下图所示。 

 

2. 选中“XB6_EC0002”，单击“Copy All Devices to Project”，如下图所示。 

 

设备已经添加，如下图所示。 
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1. 单击“Online > Multiple”，选择“总是执行完全下载”。 

2. 单击菜单栏中的“Online > Login”。 

● 手动添加设备 

按模块组装顺序逐一添加，顺序出现错误，系统将不能正常运行。 

1. 选中“EtherCAT_Master (EtherCAT Master)”。 

2. 右键单击“Add Device”，出现“Add Device”界面，选择耦合器，例如下图。 

 

3. 选中耦合器，单击“Add Device”，添加 I/O 模块，如下图所示。 
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5. 测试 IO 模块。 

● 配置 IO 模块总线模式 

1. 单击“Logout”按钮，退出 PLC。 

2. 双击耦合器，切换到“EhterCAT I/O Mapping”页签。 

3. 在右下角下拉列表“Always update variables”选择“Enabled1”模式，如下图所示。 

 

4. 执行下载，单击“Online Multiple” 。 

5. 输入、输出测试。 

1. 单击“登录到”按钮重新登录。 

2. 双击耦合器，单击“Prepared Value”单元格。 

3. 单击上方菜单栏“调试 > 写入值”。 
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6. 模块参数设置。 

输出清空保持设置 

1. 在左侧导航栏中双击耦合器 XB6-EC0002，在其属性标签页选中“EtherCAT I/O Mapping”

页面。 

 

2. 在系统运行状态下，输入“预备值”，单击“调试 > 写入值”，修改“CouperCtrl”值。 

0：输出清空 

1：输出保持 

模拟量量程及滤波设置 

1. 启用专家设置。 

退出登录，在左侧导航栏中双击耦合器 XB6-EC0002，在其属性标签页选中“Startup 

Parameters”页面。 

 

2.  单击“Add”按钮，显示“Select Item from Object Directory”页面。 
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在“Select Item from Object Directory”页面，可对量程范围和滤波参数进行设置。 

 


